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This Chapter Contains:

� Instructions for enriching, fragmenting, and labeling RNA target from E. coli cells.

After completing the procedures described in this chapter, the labeled and fragmented target 
is hybridized to the GeneChip E. coli Genome Array, as described in Section 3, Chapter 3.
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3.1.4

Introduction

This chapter describes the assay procedures recommended for use with GeneChip E. coli 
Genome Array. These procedures differ from those described under the previous section 
primarily because, unlike their eukaryotic counterpart, the majority of E. coli messenger 
RNAs do not contain poly-A tails. To enrich for mRNA species, a procedure designed to 
remove 16S and 23S ribosomal RNAs, which constitute approximately 90% of the total 
RNA population, is utilized. The resulting RNA population is then directly labeled with 
biotin.

mRNA Enrichment Procedure

The enrichment procedure is a series of enzymatic steps that specifically eliminate the 16S 
and 23S rRNA species in the total E. coli RNA. Reverse transcriptase and primers specific 
to 16S and 23S rRNA are used to synthesize complementary DNAs. Then rRNA is removed 
enzymatically by treatment with RNase H, which specifically digests RNA within an 
RNA:DNA hybrid. The cDNA molecules are then removed by DNase I digestion and the 
enriched mRNA is purified on QIAGEN RNeasy columns.

RNA Fragmentation and Labeling Procedure

The direct labeling of RNA consists of the following steps:

1. The RNA is fragmented by heat and ion-mediated hydrolysis. 

2. The 5´-end RNA termini are enzymatically modified by T4 polynucleotide kinase with 
γ-S-ATP. 

3. Biotin is conjugated to 5´-ends of the RNA. After purification of the product, the 
efficiency of the labeling procedure can be assessed using a gel-shift assay described in 
Gel-Shift Assay on page 3.1.14.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

Total RNA Isolation
� MasterPure™ RNA Purification Kit, Epicentre Technologies, P/N MCR85102

� Isopropanol

� 75% Ethanol

mRNA Enrichment Procedure
� MMLV Reverse Transcriptase, New England BioLabs, P/N M0253L

� 10X MMLV Reverse Transcriptase Buffer, New England BioLabs, P/N M0253L 
(contains DTT and is also supplied with MMLV Reverse Transcriptase)

� 16S rRNA Primers

� 23s rRNA Primers

� dATP, dCTP, dGTP, dTTP, Amersham Pharmacia Biotech, P/N 27-2035-01

� SUPERase•In™, Ambion, P/N 2696

� Ribonuclease H (RNase H), E. coli, Epicentre Technologies, P/N R0601K

� Deoxyribonuclease I (DNase I), Amersham Pharmacia Biotech, P/N 27-0514-01

� 0.5 M EDTA, pH 8.0, Invitrogen Life Technologies, P/N 15575-038

� RNeasy Mini Kit, QIAGEN, P/N 74104

� β-Mercaptoethanol

� 96% to 100% Ethanol

� Nuclease-free Water, Ambion, P/N 9930

Name Sequence

16S1514 5´-CCTAC GGTTA CCTTG TT-3´
16S889 5´TTAAC CTTGC GGCCG TACTC-3´
16S541 5´-TCCGA TTAAC GCTTG CACCC-3´

Name Sequence

23S2878 5´-CCTCA CGGTT CATTA GT-3´
23SEco2064 5´-CTATA GTAAA GGTTC ACGGG-3´
23SEco1595 5´-CCTGT GTCGG TTTGG GGT-3´
23S1022 5´-TCCCA CATCG TTTCC CAC-3´
23S539 5´-CCATT ATACA AAAGG TAC-3’

All primers should be purchased in the 1 µmole amount and purified by HPLC. 
Oligonucleotides purchased from Operon have been used successfully in the 
procedure described in this chapter.
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RNA Fragmentation and Labeling Reaction
� T4 Polynucleotide Kinase and 10X NEBuffer, New England BioLabs, P/N 201L

� γ-S-ATP (20 µmoles), Roche Molecular Biochemical, P/N 1162306

� MOPS, Sigma-Aldrich, P/N M3183

� PEO-Iodoacetyl-Biotin (50 mg), Pierce Chemical, P/N 21334ZZ

� 3 M Sodium Acetate (NaOAc), pH 5.2, Sigma-Aldrich, P/N S 7899

� 96% to 100% Ethanol

� RNA/DNA Mini Column Kit, QIAGEN, P/N 14123

� β-Mercaptoethanol

� Isopropanol

� 70% Ethanol

� Glycogen (20 mg/mL), Roche Molecular Biochemical, P/N 901393

Gel-Shift Assay
� Novex XCell SureLock™ Mini-Cell, Invitrogen, P/N EI9001

� 4-20% TBE Gel, 1.0 mm, 12 well, Invitrogen, P/N EC62252

� Sucrose Gel Loading Dye, 5X, Amresco, P/N E-274

� 10X TBE Running Buffer

� SYBR Gold, Molecular Probes, P/N S-11494

� 10 bp and 100 bp DNA ladder, Invitrogen Life Technologies, P/N 10821-015 and 
15628-019, respectively

� ImmunoPure NeutrAvidin, Pierce Chemical, P/N 31000ZZ

� 1M Tris pH 7.0, Ambion, P/N 9850G

Miscellaneous Supplies
� Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 
(or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips

� Thermocycler

� Refrigerated microcentrifuge

� Spectrophotometer and quartz micro cuvettes

� Gel imaging system with appropriate filter for SYBR Green II or Gold. 

� PCR tubes

� 0.2 µm filters for liquid sterilization

� Tough Spots, Label Dots, USA Scientific, P/N 9902 (optional)
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Reagent Preparation

mRNA Enrichment Procedure

rRNA Removal Primer Stock

Individual primers are maintained at a stock concentration of 100 µM. Each primer is 
diluted 10-fold in the final primer mix to a concentration of 10 µM. Individual stocks 
and the primer mix are stored at -20°C.

25 mM dNTP Mix

Add 50 µL of each dNTP stock solution (100 mM each) to a sterile microcentrifuge tube. 
Mix thoroughly. Store at -20°C.

RNA Fragmentation and Labeling Reaction

500 mM MOPS, pH 7.5

For 100 mL:

10.5 g MOPS

80 mL Distilled water

Mix and adjust pH to 7.5 with 1 M NaOH. Add Distilled water to 100 mL. 
Filter through 0.2 µM filter. Store at room temperature.

Gel-Shift Assay

2 mg/mL NeutrAvidin

Resuspend 10 mg NeutrAvidin in 5 mL solution containing 50 mM Tris-Cl, pH 7.6, 
200 mM NaCl. Store at 4°C.
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Total RNA Isolation

Prior to the enrichment process, total RNA is isolated. For E. coli, Affymetrix has 
successfully used the Epicentre MasterPure RNA Purification Kit. Typical yields from a 
10 mL log-phase culture range from 80 to 400 µg of total RNA. After purification, the RNA 
concentration is determined by absorbance at 260 nm on a spectrophotometer (1 absorbance 
unit = 40 µg/mL RNA). The A260/A280 ratio should be approximately 2.0, with ranges 
between 1.8 to 2.1 considered acceptable. We recommend checking the quality of the RNA 
by running it on an agarose gel prior to starting the assay. The figure below shows 1 µg 
samples from three acceptable RNA preparations. The 23S and 16S rRNA bands should be 
clear without any obvious smearing patterns.

Figure 3.1.1    

Typical RNA preparations from E. coli

Lane 1 - 1 µg Sample 1
Lane 2 - 1 µg Sample 2
Lane 3 - 1 µg Sample 3
Lane 4 - RNA Size Markers
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mRNA Enrichment Procedure

The following protocol starts with 100 µg of total RNA.  Incubations are performed in a 
thermocycler. Each sample is equally split between four 200-µL PCR tubes. It takes 
approximately 5 hours to obtain enriched mRNA.

Step 1: cDNA Synthesis

1. Prepare the following mixture in each of the four PCR tubes.

2. Heat RNA and primer mixture to 70°C for 5 minutes and then cool to 4°C. 

3. Add the following components to each of the four tubes.

The enrichment procedure involves three enzymatic steps, and the amount of 
enzymes used and incubation time are critical to the success of the assay. Please 
exercise precautions and follow standard laboratory procedures when handling RNA 
samples.

Optionally, 1 µL of control transcript mix (lys, phe, dap, thr, and trp from B. subtilis) 
can be added to total RNA prior to the enrichment procedure for a final concentration 
of 10 pM of each control transcript to be applied to the arrays. Please refer to 
Section 3, Chapter 2 for the detailed protocol to prepare control sense RNA.

The detection limit of the assay is estimated to be around 5 pM. Assuming complete 
recovery of spike transcripts, the final hybridization mix contains each transcript at 
10 pM concentration that is slightly above detection limit. Detection of these controls 
on the GeneChip E. coli Genome Array serves as indicators of the labeling efficiency. 
Alternatively, various control transcripts can also be spiked in at variable 
concentrations to demonstrate the dynamic range of the assay.

Table 3.1.1

Primer Mixture for mRNA Enrichment

Components Volume or Amount Final Concentration

Total RNA 25.0 µg 0.83 µg/µL

10 µM rRNA Removal Primer Stock 7 µL 1.75 µM

500 pM Control Transcript (optional) 1 µL

Nuclease-free DI H2O Up to 40.0 µL —

Total Volume Added 40 µL

Table 3.1.2

Reverse Transcription Components

Components Volume Final Concentration

10X MMLV RT Buffer 10.0 µL 1X

25.0 mM dNTP Mix 2.0 µL 0.5 mM

20 U/µL SUPERase•In 3.0 µL 0.6 U/µL

200 U/µL MMLV RT 2.5 µL 5 U/µL

Nuclease-free H2O 42.5 µL —

Total Volume Added 60 µL
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4. Incubate the reaction at 42°C for 25 minutes, then at 45°C for 20 minutes.
Cool to 4°C.

5. Inactivate the enzyme at 65°C for 5 minutes, then hold at 4°C. Proceed immediately to 
Step 2: rRNA Digestion, below.

Step 2: rRNA Digestion

1. Add the following to each of the four tubes.

2. Incubate the reaction at 37°C for 25 minutes, then hold at 4°C. Proceed immediately to 
Step 3: cDNA Digestion below.

Step 3: cDNA Digestion

1. Add the following to each of the four tubes.

2. Incubate the reaction at 37°C for 20 minutes. 

3. Inactivate the enzyme by adding 3 µL of 500 mM EDTA to each tube for a final 
concentration of 10.0 mM.

4. Pool reaction product from all four tubes and clean up the enriched mRNA with 
QIAGEN RNeasy Mini column.

5. Quantify the enriched mRNA preparation by 260 nm absorbance. Typical yields for the 
procedure are 20 to 40 µg of RNA (1.0 A260 unit = 40 µg/mL single strand RNA).

Table 3.1.3

RNase Digestion of rRNAs

Components Volume Final Concentration

10.0 U/µL RNase H 4.0 µL 0.4 U/µL

20 U/µL SUPERase•In 3.0 µL 0.6 U/µL

Total Volume Added 7 µL

Table 3.1.4

Digestion of cDNA

Components Volume Final Concentration

5.0 U/µL DNase I* 4.0 µL 0.2 U/µL

*Dilute 10 U/µL DNase I to 5 U/µL with nuclease-free H2O.

The concentration of DNase I is critical. Excessive digestion may cause degradation 
of mRNA.  Lot-to-lot variation of enzyme activity may occur.  Therefore, titrate DNase 
concentrations when necessary.

The concentration and incubation time for DNase I are critical. Under-digestion is 
preferable to over-digestion.

The enriched mRNA is stored at -20°C until ready for use in the subsequent 
fragmentation and labeling reaction.
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RNA Fragmentation and Labeling 
Reaction

As in the previous procedure, the fragmentation and labeling reactions are done in PCR 
tubes in a thermocycler. A maximum of 20 µg of RNA per tube is used in the fragmentation 
step. Incomplete fragmentation may occur if excess RNA is used. Split samples into 
multiple tubes if the yield of RNA from the enrichment step is greater than 20 µg. Following 
the 5´ thiolation and biotin addition reaction, the target is purified with ethanol precipitation 
or RNA/DNA Mini Columns. The reactions take about 6 hours to complete.

Step 1:  RNA Fragmentation

1. Prepare the following mixture.

2. Incubate the reaction at 95°C for 30 minutes.

3. Cool to 4°C.

Step 2:  RNA 5´-Thiolation

1. Prepare the following mixture.

2. Incubate the reaction at 37°C for 50 minutes. 

3. Inactivate the reaction by heating at 65°C for 10 minutes and then cool to 4°C.

The reaction of PEO-Iodoacetyl-Biotin is highly pH-dependent.  MOPS is used as the 
buffer because of its inability to react with the iodoacetyl group under the reaction 
conditions. Other commonly used laboratory buffers containing amino groups such 
as Tris should not be used because of their reactivity with the iodoacetyl moiety.

Table 3.1.5

RNA Fragmentation Mix

Components Volume or Amount Final Concentration

10X NEBuffer for T4 Polynucleotide Kinase 10.0 µL 1.1X

enriched mRNA up to 20.0 µg —

DI H2O up to 88.0 µL total volume —

Final Volume 88 µL

Table 3.1.6

RNA Thiolation Mix

Components Volume Final Concentration

Fragmented RNA (from Step 1) 88.0 µL —

5 mM γ-S-ATP 2.0 µL 0.1 mM

10 U/µL T4 Polynucleotide Kinase 10.0 µL 1 U/µL

Final Volume 100.0 µL
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4. Remove excess γ-S-ATP by ethanol precipitation. If you have started with multiple 
tubes, combine all samples in one sterile microcentrifuge tube. Add 1/10 volume of 
3 M sodium acetate, pH 5.2, and 2.5 volumes of ethanol.  Leave on ice for 15 minutes.

5. Spin at 14,000 rpm at 4°C for 30 minutes to pellet the RNA. 

6. Resuspend the RNA pellet in 90 µL of DI H2O.

Step 3:  Biotin Addition

1. Prepare the following mixture.

2. Incubate the reaction at 37°C for one hour. 

3. Cool to 4°C.

4. Remove unincorporated biotin label using the QIAGEN RNA/DNA Mini Columns.

5. Dissolve the pelleted RNA in 20 to 30 µL of nuclease-free water.

6. Quantify product by 260 nm absorbance. Typical yields for the procedure are 2 to 4 µg 
of RNA. The labeled RNA should be stored at -20°C until ready for gel analysis or 
hybridization, as described in Section 3, Chapter 3.

Table 3.1.7

RNA Labeling Mix

Components Volume Final Concentration

500 mM MOPS, pH 7.5 6.0 µL 30 mM

Fragmented thiolated RNA (from Step 2) 90.0 µL —

50 mM PEO-Iodoacetyl-Biotin 4.0 µL 2 mM

Final Volume 100.0 µL

For increased RNA recovery, use one RNA/DNA column and 5.4 mL Buffer QRV2 for 
every 10.0 µg RNA. It is recommended to add 50 µg of glycogen as carrier during the 
precipitation step.  

Alternatively, clean up the labeling product by ethanol precipitation instead of 
Qiagen columns (add 50 µg of glycogen as carrier, 1/10 volume of 3 M sodium 
acetate and 2.5 volume of ethanol to samples), followed by twice washing the pellets 
with 750 µL of 70% ethanol.

The process may be stopped during ethanol precipitation following the RNA/DNA 
column purification.
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Gel-Shift Assay

After purification of the target, the efficiency of the labeling procedure can be assessed 
using the following procedure. This quality control protocol prevents hybridizing poorly 
labeled target onto the probe array. The addition of biotin residues is monitored in a gel-
shift assay where the fragments are incubated with avidin prior to electrophoresis. Biotin-
containing residues are retarded or shifted during the electrophoresis due to avidin binding. 
The nucleic acids are then detected by staining. Affymetrix routinely obtains approximately 
70% labeling efficiency as shown in the gel photograph (Figure 3.1.2). The procedure takes 
approximately 90 minutes to complete.

1. Prepare a NeutrAvidin solution of 2 mg/mL or higher. 50 mM Tris, pH 7.0 can be used 
to dilute the NeutrAvidin solution.

2. Place a 4-20% TBE gel into the gel holder and load system with 1X TBE Buffer.

3. For each sample to be tested, remove two 150 to 200 ng aliquots of fragmented and 
biotinylated sample to fresh tubes.

4. Add 5 µL of 2 mg/mL NeutrAvidin to each tube.

5. Mix and incubate at room temperature for 5 minutes.

6. Add loading dye to all samples to a final concentration of 1X loading dye.

7. Prepare 10 bp and 100 bp DNA ladders (1µL ladder + 7 µL water + 2 µL loading dye 
for each lane).

8. Carefully load samples and two ladders on gel. (Each gel well can hold a maximum of 
20 µL.)

The absence of a shift pattern indicates poor biotin labeling. The problem should be 
addressed before proceeding to the hybridization step.

Figure 3.1.2    

Gel-shift assay for monitoring E. coli target labeling efficiency

Lane 1 - 10 bp DNA Ladder
Lane 2 - Fragmented and labeled enriched E. coli RNA
Lane 3 - Fragmented and labeled enriched E. coli RNA 

with avidin
Lane 4 - Fragmented and labeled total E. coli RNA
Lane 5 - Fragmented and labeled total E. coli RNA with avidin
Lane 6 - 100 bp DNA Ladder
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9. Run the gel at 150 volts until the front dye (red) almost reaches the bottom. The 
electrophoresis takes approximately 1 hour.

10. While gel is running, prepare at least 100 mL of a 1X solution of SYBR Green II or 
Gold for staining.

11. After the gel is complete, break open cartridge and stain the gel in 1X SYBR Green II 
or Gold for 10 minutes.

12. Place the gel on the UV light box and produce an image following standard procedure. 
Be sure to use the appropriate filter for SYBR Green II or Gold.

SYBR Green II and Gold are light sensitive. Therefore use caution and shield the 
staining solution from light.  Prepare a new batch of stain at least once a week.
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Preparation of Control Spike Transcripts for 
GeneChip® E. coli Genome Array

Overview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.4

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.5

Bacterial Plasmid DNA Preparation   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.6

Linearization of Plasmid DNA Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.7

Purification of Linearized Plasmid DNA  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.7

In Vitro Transcription (IVT) to Produce Control Sense Transcripts .  .  .  .  .  .  .  .  .  . 3.2.8

Preparing the Control Transcript Mix .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.8

This Chapter Contains:

� Detailed steps for producing full-length control spike sense RNA.

After completing the procedures described in this chapter, the control sense transcripts can 
be added to purified E. coli RNA samples prior to enrichment and labeling procedure as 
described in Section 3, Chapter 1.
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Overview

This chapter describes protocols used to generate sense RNA controls from B. subtilis 
genes. These control transcripts can be spiked into E. coli total RNA used for target 
preparation at a predetermined concentration to monitor labeling, hybridization, and 
staining efficiency.

To be used as control for assay performance, the GeneChip® E. coli Genome Array contains 
probe sets with sequences of dap, thr, phe, lys, and trp genes from B. subtilis. These genes 
have been cloned into Stratagene pBluescript as an Xho I to Not I insert, 5´ to 3´, 
respectively (see Section 2, Chapter 2, Controls for Eukaryotic Arrays).

pGIBS-lys ATCC 87482

pGIBS-phe ATCC 87483

pGIBS-thr ATCC 87484

pGIBS-trp ATCC 87485

pGIBS-dap ATCC 87486

These clones can be digested with the Not I restriction enzyme to produce linear template 
DNA for the subsequent in vitro transcription (IVT) to produce sense strand RNA by T3 
RNA polymerase as control molecules. 

Bacteria containing these recombinant plasmids can be obtained from the American Type 
Culture Collection (ATCC). 

T3 5’

Xho I Not I

3’ T7
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Expression Control Clones, American Type Culture Collection (ATCC)

� pGIBS-lys ATCC 87482

� pGIBS-phe ATCC 87483

� pGIBS-thr ATCC 87484

� pGIBS-trp ATCC 87485

� pGIBS-dap ATCC 87486

� Not I restriction Endonuclease, New England BioLabs, P/N R0189S

� Phase Lock Gel, Brinkmann Instruments, P/N 955 15 415
� Phenol/chloroform/isoamyl alcohol, Ambion, P/N 9732

� MEGAscript T3 Kit, Ambion, P/N 1338

Miscellaneous Reagents
� 3 M NaAcetate (NaOAc)

� Absolute Ethanol

� 80% Ethanol

� RNeasy Mini Kit, QIAGEN, P/N 74104
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Bacterial Plasmid DNA Preparation

1. Grow E. coli bacterial cultures containing recombinant plasmids according to 
established protocols (a minimum 50 mL of culture volume is recommended).

2. Prepare plasmid DNA from overnight cultures using standard procedures or 
commercial kits.

Affymetrix has obtained reliable results using QIAGEN Plasmid Kits for plasmid DNA 
isolation.
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Linearization of Plasmid DNA 
Preparation

1. In a 50 µL reaction volume, digest 10 µg of plasmid with the restriction enzyme, NotI, 
according to the enzyme manufacturer’s recommendations.

2. Analyze 50 ng of the uncut and linearized plasmid by gel electrophoresis on a 
1% agarose gel. Complete digestion of the plasmid is required for IVT. Repeat 
restriction enzyme digestion, if necessary.

Purification of Linearized Plasmid 
DNA

Purify the linearized plasmid from restriction enzymes and potential RNase contaminants 
before proceeding to IVT using a Phase Lock Gel-phenol/chloroform extraction procedure.

Phase Lock Gels (PLG) form an inert, sealed barrier between the aqueous and organic 
phases of phenol-chloroform extractions. The solid barrier allows more complete recovery 
of the sample (aqueous phase) and minimizes interface contamination of the sample. PLG’s 
are sold as premeasured aliquots in 1.5 mL tubes to which sample and phenol chloroform 
are directly added.

1. Pellet the Phase Lock Gel (1.5 mL tube with PLG I-heavy) in a microcentrifuge at 
≥ 12,000 x g for 20 seconds.

2. Dilute the linearized plasmid to final volume of 150 µL with TE and add equal volume 
of (25:24:1) Phenol:chlorororm:isoamyl alcohol (saturated with 10 mM Tris-HCl 
pH8.0/1 mM EDTA). Vortex.

3. Transfer the mix to the PLG tube and microcentrifuge at ≥ 12,000 x g for 2 minutes.

4. Transfer the top aqueous phase to a new 1.5 mL tube.

5. Add 0.1 volumes (15 µL) of 3 M NaOAc and 2.5 volumes (375 µL) of absolute ethanol 
to the samples. Vortex.

6. Immediately centrifuge at ≥ 12,000 x g in a microcentrifuge at room temperature for 
20 minutes.

7. Carefully remove supernatent.

8. Wash pellet with 0.5 mL of 80% ethanol, then centrifuge at ≥ 12,000 x g at room 
temperature for 5 minutes.

9. Remove the supernatent very carefully and air dry the pellet.

10. Resuspend DNA pellet in 15 µL of RNase-free water.

11. Quantify the DNA by absorbance at 260 nm (50 µg/mL of DNA for 1 absorbance unit 
at 260 nm).

The quality of DNA template can be monitored by the A260/A280 ratio, which should be 
between 1.8 and 2.0 for pure DNA.
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In Vitro Transcription (IVT) to Produce 
Control Sense Transcripts

Use MEGAscript T3 High Yield Transcription Kit for the IVT reaction.

1. To make up the reaction mix, follow the procedures in the instruction manual provided 
by Ambion.

2. Incubate the reaction for 4 hours at 37°C.

3. Cleanup the reaction product with RNeasy Mini column.

4. Quantify the transcript by absorbance at 260 nm (40 µg/mL RNA = 1 absorbance unit 
at 260 nm).

Preparing the Control Transcript Mix

1. Prepare stock solutions for each of the five transcripts separately at 2.5 nM for each 
transcript.

Use the following table to calculate the amount of transcript needed to prepare 2.5 nM 
stock.

2. Mix equal volume of all five transcripts so that final concentration for each is 500 pM.

3. Apply 4 µL of the transcript mix with each 100 µg of total RNA prior to the enrichment 
procedure as described in Chapter 1 of this section. Final concentration applied on the 
array for the control transcripts would be 10 pM, assuming 100% recovery.

No tracer is involved in this assay.

It is recommended to examine the quality and integrity of the IVT product on an 
agarose gel.

Aliquot and freeze the IVT transcripts at -80°C.  Avoid repeated freeze / thaw cycles.

Table 3.2.1

Conversions for Preparing 2.5 nM Control Transcript Mix

Control RNA Size (kb) Molecular Weight pMoles / µg

   Lys 1 330,000 3.03

   Phe 1.32 435,600 2.30

   Dap 1.82 607,200 1.65

   Thr 1.98 653,400 1.53

   Trp 2.5 kb 825,000 1.21

Since the hybridization mix has a volume of 200 µL, 10 pM would be the final 
concentration for the transcripts assuming 100% recovery throughout the 
enrichment and labeling procedure.   Alternatively, different concentrations of 
transcript stock can be prepared to generate “variable” concentrations for different 
transcripts to monitor the dynamic range of the assay.

Aliquot and freeze the IVT transcripts at -80°C.  Avoid repeated freeze / thaw cycles.
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E. coli Target Hybridization

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.6

E. coli Target Hybridization   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.7

This Chapter Contains:

� Detailed steps for preparing the hybridization mix containing labeled target.

� Instructions for hybridizing the target mix to a GeneChip E.coli Genome Array.

After completing the procedures described in this chapter, the hybridized probe array is then 
ready for washing, staining, and scanning as detailed in Section 3, Chapter 4.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 
51200

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� Herring Sperm DNA, Promega Corporation, P/N D1811

� Micropure Separator, Millipore, P/N 42512 (optional)

� Control Oligo B2, 3 nM, Affymetrix, P/N 900301 (can be ordered separately)

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� MES Free Acid Monohydrate SigmaUltra, Sigma-Aldrich, P/N M5287 

� MES Sodium Salt, Sigma-Aldrich, P/N M5057

� EDTA Disodium Salt, 0.5 M solution (100 mL), Sigma-Aldrich, P/N E7889

Miscellaneous Reagents
� Tough Spots, Label Dots, USA Scientific, P/N 9185 (optional)

� Tween-20, 10%, Pierce Chemical, P/N 28320

Miscellaneous Supplies
� Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific,
P/N 1415-2600 (or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips
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Reagent Preparation

12X MES Stock

(1.22 M MES, 0.89 M [Na+])

For 1000 mL:

70.4 g MES-free acid monohydrate

193.3 g MES Sodium Salt

800 mL of Molecular Biology Grade water

Mix and adjust volume to 1000 mL.

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter.

2X Hybridization Buffer

(Final 1X concentration is 100 mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween 20)

For 50 mL:

8.3 mL of 12X MES Stock

17.7 mL of 5 M NaCl

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween 20

19.9 mL of water

Store at 2°C to 8°C, and shield from light

 Do not autoclave, store at 2°C to 8°C, and shield from light. Discard solution if yellow.
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E. coli  Target Hybridization

After determining that the fragmented RNA is labeled with biotin, prepare the hybridization 
solution mix. The recommended amount of RNA per assay is 1.5 to 4.0 µg. The solution is 
stable for approximately 6 to 8 hours at 4°C. The following protocol can be used for freshly 
prepared or frozen hybridization cocktail. Re-use of prokaryotic sample is not 
recommended, since the samples are end-labeled rather than internally labeled.

1. Prepare the following hybridization solution mix.

2. Equilibrate probe array to room temperature immediately before use.

3. Add the hybridization solution mix to the probe array.

4. Place probe array in the hybridization oven set at 45°C.

5. Avoid stress to the motor; load probe arrays in a balanced configuration around 
rotisserie axis. Rotate at 60 rpm.

6. Hybridize for 16 hours.

During the latter part of the 16-hour hybridization, proceed to Section 3, Chapter 4 to 
prepare reagents required immediately after completion of hybridization.

Table 3.3.1 

Hybridization Solution Mix

Components Volume Final Concentration

2X MES Hybridization Buffer             100.0 µL 1X

3 nM Control Oligo B2                3.3 µL 50 pM

10 mg/mL Herring Sperm DNA                2.0 µL 0.1 mg/mL

50 mg/mL BSA                2.0 µL 0.5 mg/mL

Fragmented Labeled RNA            1.5 to 4.0 µg —

Molecular Biology Grade Water  to a final volume of 200 µL —

Final Volume                 200 µL

It is important to allow the arrays to normalize to room temperature completely. 
Specifically, if the rubber septa are not equilibrated to room temperature, they may 
be prone to cracking which can lead to leaks.

It is necessary to use two pipette tips when filling the probe array cartridge: one for 
filling, and the second to allow venting of air from the hybridization chamber. After the 
addition of hybridization cocktail, the septa may be covered with Tough Spots to 
prevent evaporation.
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GeneChip E. coli Genome Array:
Washing, Staining, and Scanning

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.6

Experiment and Fluidics Station Setup  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.7

Step 1: Defining File Locations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.7

Step 2: Entering Experiment Information.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.7

Step 3: Preparing the Fluidics Station.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.8

Probe Array Wash and Stain   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.4.9

Probe Array Scan  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3.4.13

Shutting Down the Fluidics Station .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3.4.14

Customizing the Protocol  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3.4.15

This Chapter Contains:

� Instructions for using the Fluidics Station 400 to automate the washing and staining of 
GeneChip E.coli Genome Arrays.

� Instructions for scanning probe arrays using the GeneArray Scanner.

After completing the procedures described in this chapter, the scanned probe array image 
(.dat file) is ready for analysis, as explained in the enclosed GeneChip Expression Analysis: 
Data Analysis Fundamentals booklet (P/N 701190).
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A, of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker Molecular Applications / Cambrex, P/N 
51200

� Distilled water, Invitrogen Life Technologies, P/N 15230-147

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866

� 5 M NaCl RNase-free, DNase-free, Ambion, P/N 9760G

� PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027

� 20X SSPE (3 M NaCl, 0.2 M NaH2PO4, 0.02 M EDTA), BioWhittaker Molecular 
Applications / Cambrex, P/N 51214

� Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I 5256

� Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500

� 10% surfact-Amps20 (Tween-20), Pierce Chemical, P/N 28320

� Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504 (or equivalent)

� ImmunoPure Streptavidin, Pierce Chemical, P/N 21125

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 (or 

equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)

� Sterile-barrier pipette tips and non-barrier pipette tips

� Tygon Tubing, 0.04″ inner diameter, Cole-Palmer, P/N H-06418-04
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Reagent Preparation

Wash A: Non-Stringent Wash Buffer

(6X SSPE, 0.01% Tween 20)

For 1000 mL:

300 mL of 20X SSPE

1.0 mL of 10% Tween-20

699 mL of water

Filter through a 0.2 µm filter

Wash B: Stringent Wash Buffer

(100 mM MES, 0.1 M [Na+], 0.01% Tween 20)

For 1000 mL:

83.3 mL of 12X MES Stock Buffer (see Section 3, Chapter 3 for reagent preparation)

5.2 mL of 5 M NaCl

1.0 mL of 10% Tween 20

910.5 mL of water

Filter through a 0.2 µm filter

Store at 2°C to 8°C and shield from light

2X Stain Buffer

(Final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween 20)

For 250 mL:

41.7 mL 12X MES Stock Buffer (see Section 3, Chapter 3 for reagent preparation)

92.5 mL 5 M NaCl

2.5 mL 10% Tween 20

113.3 mL water

Filter through a 0.2 µm filter

Store at 2°C to 8°C and shield from light

10 mg/mL Goat IgG Stock

Resuspend 50 mg in 5 mL PBS

Store at 4°C

1 mg/mL Streptavidin Stock

Resuspend 5 mg in 5 mL of PBS

Store at 4°C
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Experiment and Fluidics Station Setup

Step 1:  Defining File Locations

Before working with Affymetrix Microarray Suite it is important to define where the 
program stores and looks for files.

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File 
Locations from the menu bar.

The File Locations window displays the locations of the following files:

� Probe Information (library files, mask files)

� Fluidics Protocols (fluidics station scripts)

� Experiment Data (.exp, .dat, .cel, and .chp files are all saved to location selected 
here)

2. Verify that all three file locations are set correctly and click OK.

Contact Affymetrix Technical Support if you have any questions regarding this 
procedure.

Step 2:  Entering Experiment Information

To wash, stain, and scan a probe array, an experiment must first be defined in Microarray 
Suite.

1. Select Run → Experiment Info from the menu bar. Alternatively, click the New 
Experiment icon on the tool bar.

⇒ The Experiment Information dialog box appears allowing the experiment name to 
be defined along with several other parameters, such as probe array type, sample 
description, and comments.

2. Type in the Experiment Name. 

3. In the Probe Array Type box, click the arrow and select Ecoli from the drop-down 
list.

Experiment name and probe array type are required. Complete as much of the other 
information as desired. The protocol information at the bottom of the dialog box is 
exported to the experiment information dialog box after the hybridization and scan are 
complete.

4. Save the experiment by selecting Save.

The name of the experiment is used by Microarray Suite to access the probe array type 
and data for the sample while it is being processed. Data files generated for the sample 
are automatically labeled to correspond to the experiment name. Microarray Suite 
automatically fills in the Protocol section of this dialog box with information on array 
processing from the fluidics station.

5. Close the Experiment Information dialog box.
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Step 3:  Preparing the Fluidics Station

The Fluidics Station 400 is used to wash and stain the probe arrays. It is operated using 
Microarray Suite.

Setting Up the Fluidics Station

1. Turn on the Fluidics Station using the toggle switch on the lower left side of the 
machine.

2. Select Run → Fluidics from the menu bar. 

⇒ The Fluidics Station dialog box appears with a drop-down list for selecting the 
experiment name for each of the fluidics station modules. A second drop-down list 
is accessed for choosing the Protocol for each of the four fluidics station modules.

Priming the Fluidics Station

Priming ensures that the lines of the fluidics station are filled with the appropriate buffers 
and the fluidics station is ready for running fluidics station protocols.

Priming should be done:

� when the fluidics station is first started.

� when wash solutions are changed.

� before washing, if a shutdown has been performed.

� if the LCD window instructs the user to prime.

1. To prime the fluidics station, select Protocol in the Fluidics Station dialog box.

2. Choose Prime for the respective modules in the Protocol drop-down list.

3. Change the intake buffer reservoir A to Non-Stringent Wash Buffer and intake buffer 
reservoir B to Stringent Wash Buffer.

4. Click Run for each module to begin priming.

Refer to the Fluidics Station 400 User’s Guide for instructions on 
connecting and addressing multiple fluidics stations.
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Probe Array Wash and Stain

Following hybridization, the wash and stain procedures are carried out by the fluidics 
station using the ProkGE-WS2 fluidics script. The procedure takes approximately 90 
minutes to complete. The use of streptavidin in the first part of the stain procedure enhances 
the overall signal.

Preparing the Staining Reagents

1. Prepare the following stain and wash solutions the day of the procedure. The solutions 
are stable for approximately 6 to 8 hours at 4°C.  Volumes given are sufficient for one 
probe array.

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either 
foil-wrapped or kept in an amber tube. Remove SAPE from refrigerator and tap the 
tube to mix well before preparing stain solution. Do not freeze SAPE. Always prepare 
the SAPE stain solution immediately before use.

Table 3.4.1 

Streptavidin Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0  µL 1X

50 mg/mL BSA 24.0  µL 2 mg/mL

1 mg/mL Streptavidin 6.0  µL 10 µg/mL

DI H20 270.0  µL —

Total Volume 600  µL
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Table 3.4.2 

Antibody Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL BSA 24.0 µL 2 mg/mL

10 mg/mL Normal Goat IgG 6.0 µL 0.1 mg/mL

0.5 mg/mL Biotin Anti-streptavidin 6.0 µL 5 µg/mL

DI H20 264.0 µL —

Total Volume 600  µL

Table 3.4.3 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL BSA 24.0 µL 2 mg/mL

1 mg/mL Streptavidin Phycoerythrin 6.0 µL 10 µg/mL

DI H20 270.0 µL —

Total Volume 600  µL

Table 3.4.4

Fluidics Protocols - Antibody Amplification for E. coli Targets

Standard Format

ProkGE-WS2

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with Wash Buffer A at 25oC

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with Wash Buffer B at 45oC

Stain Stain the probe array for 10 minutes in Streptavidin Solution. Mix at 25oC

Post Stain 
Wash

10 cycles of 4 mixes/cycle with Wash Buffer A at 30oC

2nd Stain Stain the probe array for 10 minutes in antibody solution. Mix at 25°C

3rd Stain Stain the probe array for 10 minutes in SAPE Solution at 25oC

Final Wash 15 cycles of 4 mixes/cycle with Wash Buffer A at 30oC. The holding temperature is 25oC

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer
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2. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name from the drop-down Experiment list. The probe array type will appear 
automatically.

3. In the Protocol drop-down list, select the ProkGE-WS2 protocol to control the 
washing and staining of the probe array format being used.

4. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions in the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics 
station modules, please refer to the Fluidics Station 400 User’s Guide, Fluidics Station 
400 Video In-Service CD (P/N 900374), or Quick Reference Card (P/N 08-0072).

5. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

6. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

7. Place a microcentrifuge tube containing 600 µL streptavidin solution into the sample 
holder, making sure that the metal sampling needle is in the tube with its tip near the 
bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress.

8. When the LCD window indicates, replace the microcentrifuge tube containing the 
streptavidin stain with a microcentrifuge tube containing 600 µL antibody stain 
solution into the sample holder, making sure that the metal sampling needle is in the 
tube with its tip near the bottom.

9. When the LCD window indicates, replace the microcentrifuge tube containing 
antibody solution with the microcentrifuge tube containing the 600 µL of SAPE 
solution.

10. When the protocol is complete, the LCD window displays the message EJECT 
CARTRIDGE.

11. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

12. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position.

13. Check the probe array window for large bubbles or air pockets. 

� If bubbles are present, refer to Table 3.4.5 on page 3.4.12.

� If the probe array has no large bubbles, it is ready to scan on the GeneArray Scanner. 
ENGAGE wash block and proceed to Probe Array Scan on page 3.4.13. 

If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark 
until ready for scanning.

If there are no more samples to hybridize, shut down the fluidics station following the 
procedure outlined in the section, Shutting Down the Fluidics Station on page 3.4.14.

Three-stain protocols require the user to replace stain solutions as directed by the LCD 
window during staining steps.
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For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Section 4, Fluidics Station Maintenance Procedures.

Table 3.4.5

If bubbles are present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 3.4.13.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually, using a micropipette. Excessive 
washing will result in a loss of signal intensity.
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Probe Array Scan

The scanner is also controlled by Affymetrix Microarray Suite. The probe array is scanned 
after the wash protocols are complete. Make sure laser is warmed up prior to scanning by 
turning the laser on at least 15 minutes before use. If probe array was stored at 4°C, warm to 
room temperature before scanning. Refer to the Microarray Suite online help and the 
appropriate scanner user’s manual for more information on scanning.

If necessary, clean the glass surface of probe array with a non-abrasive towel or tissue 
before scanning. Do not use alcohol to clean glass.

1. Select Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in 
the tool bar.

⇒ The Scanner dialog box appears with a drop-down list of experiments that have not 
been run. 

2. Select the experiment name that corresponds to the probe array to be scanned. 

A previously run experiment can also be selected by using the Include Scanned 
Experiments option box. After selecting this option, previously scanned experiments 
appear in the drop-down list.

3. By default, after selecting the experiment the number [2] is displayed in the Number of 
Scans box to perform the recommended 2X image scan.

4. Once the experiment has been selected, click the Start button.

⇒ A dialog box prompts you to load a sample into the scanner.

5. Click the Options button to check for the correct pixel value and wavelength of the 
laser beam.

� Pixel value = 3 µm

� Wavelength = 570 nm

6. Open the sample door on the scanner and insert the probe array into the holder. Do not 
force the probe array into the holder. Close the sample door of the scanner.

7. Click OK in the Start Scanner dialog box.

⇒ The scanner begins scanning the probe array and acquiring data. When Scan in 
Progress is Selected from the View menu, the probe array image appears on the 
screen as the scan progresses.

The scanner uses an argon-ion laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser light.
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Shutting Down the Fluidics Station

1. After removing a probe array from the probe array holder, the LCD window displays 
the message ENGAGE WASHBLOCK. 

2. Engage the washblock by firmly pushing up on the probe array lever to the ENGAGE 
position.

The fluidics station will automatically perform a Cleanout procedure. The LCD 
window will indicate the progress of the Cleanout procedure.

3. When the fluidics station LCD window indicates REMOVE VIAL, the Cleanout 
procedure is complete.

4. Remove the sample microcentrifuge tube from the sample holder.

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with 
deionized water.

6. Select Shutdown for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules.

The Shutdown protocol is critical to instrument reliability. Refer to the Fluidics Station 
400 User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to 
the OFF position.

To maintain the cleanliness of the fluidics station and obtain the highest quality image 
and data possible, a weekly bleach protocol and a monthly decontamination protocol 
are highly recommended. Please refer to Section 4, Fluidics Station Maintenance 
Procedures for further detail.
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Customizing the Protocol

There may be times when the fluidics protocols need to be modified. Modification of 
protocols must be done before downloading the protocol to the fluidics station. Protocol 
changes will not affect runs in progress. For more specific instructions, refer to the 
Microarray Suite online help.

1. Select Tools → Edit Protocol from the menu bar.

2. In the Edit Protocol dialog box under Protocol Name, click the arrow to open a list of 
protocols. Click the protocol to be changed.

⇒ The name of the protocol is displayed in the Protocol Name text box. The 
conditions for that protocol are displayed on the right side of the Edit Protocol 
dialog box.

3. Select the item to be changed and input the new parameters as needed, keeping 
parameters within the ranges shown below in Table 3.4.6.

4. To return to the default values for the protocol selected, click the Defaults button.

5. Once all the protocol conditions are modified as desired, change the name of the edited 
protocol in the Protocol Name box.

6. Click Save, then close the dialog box.

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, 
enter 0 (zero) for the stain time if staining is not required. Enter 0 (zero) for the number 
of wash cycles if a wash solution is not required.

Table 3.4.6

Valid Ranges for Wash/Stain Parameters

Parameter Valid Range

Wash Temperature for A1, B, A2, or A3 (°C) 15 to 50

Number of Wash Cycles for A1, B, A2, or A3 0 to 99

Mixes / Wash cycle for A1, B, A2, or A3 15 to 50

Stain Time (seconds) 0 to 86,399

Stain Temperature (°C) 15 to 50

Holding Temperature (°C) 15 to 50

• Wash A1 corresponds to Post Hyb wash #1 in Table 3.4.4.
• Wash B corresponds to Post Hyb wash #2 in Table 3.4.4.
• Wash A2 corresponds to Post Stain Wash in Table 3.4.4.
• Wash A3 corresponds to Final Wash in Table 3.4.4.

If the protocol is saved without entering a new Protocol Name, the original protocol 
parameters will be overwritten.
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